Chapter 165
Equivalence Tests for the Difference Between Two Correlated Proportions

Introduction
The procedure described in this chapter computes power and sample size for testing equivalence using differences in designs in which two dichotomous responses are measured on each subject.

When one is interested in showing that two correlated proportions are different, the data are often analyzed with McNemar’s test. However, the procedures discussed here are interested in showing equivalence rather than difference. For example, suppose a diagnostic procedure is accurate, but is expensive to apply or has serious side effects. A replacement procedure may be sought which is equally accurate, but is less expensive or has fewer side effects. In this case, we are not interested in showing that the two diagnostic procedures are different, but rather that they are the same. Equivalence tests were designed for this situation.

These tests are often divided into two categories: equivalence (two-sided) tests and non-inferiority (one-sided) tests. Here, the term equivalence tests means that we want to show that two diagnostic procedures are equivalent—that is, their accuracy is about the same. This requires a two-sided hypothesis test. On the other hand, non-inferiority tests are used when we want to show that a new (experimental) procedure is no worse than the existing (reference or gold-standard) one. This requires a one-sided hypothesis test.

Technical Details
The results of a study in which two dichotomous responses are measured on each subject can be displayed in a 2-by-2 table in which one response is shown across the columns and the other is shown down the rows. In the discussion to follow, the columns of the table represent the standard (reference or control) response and the rows represent the treatment (experimental) response. The outcome probabilities can be classified into the following table.

<table>
<thead>
<tr>
<th>Experimental Diagnosis</th>
<th>Standard Diagnosis</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>$p_{11}$</td>
<td>$p_{10}$</td>
</tr>
<tr>
<td>No</td>
<td>$p_{01}$</td>
<td>$p_{00}$</td>
</tr>
<tr>
<td>Total</td>
<td>$P_S$</td>
<td>$1 - P_S$</td>
</tr>
</tbody>
</table>

In this table, $p_{ij} = P_{\text{Treatment, Standard, } i,j}$. That is, the first subscript represents the response of the new, experimental procedure while the second subscript represents the response of the standard procedure. Thus, $p_{01}$ represents the proportion having a negative treatment response and a positive standard response.
Sensitivity, Specificity, and Prevalence

To aid in interpretation, analysts have developed a few proportions that summarize the table. Three of the most popular ratios are sensitivity, specificity, and prevalence.

Sensitivity
Sensitivity is the proportion of subjects with a positive standard response who also have a positive experimental response. In terms of proportions from the 2-by-2 table,

\[
\text{Sensitivity} = \frac{p_{11}}{p_{01} + p_{11}} = \frac{p_{11}}{P_S}
\]

Specificity
Specificity is the proportion of subjects with a negative standard response who also have a negative experimental response. In terms of proportions from the 2-by-2 table,

\[
\text{Specificity} = \frac{p_{00}}{p_{10} + p_{00}}
\]

Prevalence
Prevalence is the overall proportion of individuals with the disease (or feature of interest). In terms of proportions from the 2-by-2 table,

\[
\text{Prevalence} = P_S
\]

Table Probabilities

The outcome counts from a sample of \( n \) subjects can be classified into the following table.

<table>
<thead>
<tr>
<th>Experimental Diagnosis</th>
<th>Standard Diagnosis</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>( n_{11} )</td>
</tr>
<tr>
<td></td>
<td>No</td>
<td>( n_{10} )</td>
</tr>
<tr>
<td></td>
<td>Total</td>
<td>( n_T )</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>( n_{01} )</td>
</tr>
<tr>
<td></td>
<td>No</td>
<td>( n_{00} )</td>
</tr>
<tr>
<td></td>
<td>Total</td>
<td>( n - n_T )</td>
</tr>
<tr>
<td></td>
<td>Total</td>
<td>( n )</td>
</tr>
</tbody>
</table>

Note that \( n_{11} + n_{00} \) is the number of matches (concordant pairs) and \( n_{01} + n_{10} \) is the number of discordant pairs.

The hypothesis of interest concerns the two marginal probabilities \( P_T \) and \( P_S \). \( P_S \) represents the accuracy or success of the standard test and \( P_T \) represents the accuracy or success of the new, experimental test. Equivalence is defined in terms of either the difference of these two proportions, \( D = P_T - P_S \), or the relative risk ratio, \( R = P_T/P_S \). The choice between \( D \) and \( R \) will usually lead to different sample sizes to achieve the same power.
Equivalence Hypotheses using Differences

This section is based on Liu, Hsueh, Hsieh and Chen (2002). We refer you to that paper for complete details. If we define $M_E$ as the positive equivalence margin, then the null and alternative hypotheses of equivalence in terms of the difference are

$$H_0: P_T - P_S \leq -M_E \text{ or } P_T - P_S \geq M_E \quad \text{versus} \quad H_1: -M_E < P_T - P_S < M_E,$$

or equivalently, with $D_{0,L} = -M_E$ and $D_{0,U} = |D_{0,L}| = M_E$,

$$H_0: P_T - P_S \leq D_{0,L} \text{ or } P_T - P_S \geq D_{0,U} \quad \text{versus} \quad H_1: D_{0,L} < P_T - P_S < D_{0,U}.$$

These hypotheses can be decomposed into two sets of one-sided hypotheses

$$H_{0L}: P_T - P_S \leq D_{0,L} \quad \text{versus} \quad H_{1L}: P_T - P_S > D_{0,L}$$

and

$$H_{0U}: P_T - P_S \geq D_{0,U} \quad \text{versus} \quad H_{1U}: P_T - P_S < D_{0,U}.$$

The hypothesis test of equivalence with type I error rate $\alpha$ is conducted by computing a $100(1 - 2\alpha)\%$ confidence interval for $P_T - P_S$ and determining if this interval is wholly contained between $D_{0,L}$ and $D_{0,U}$. This confidence interval approach is often recommended by regulatory agencies.

Liu et al. (2002) discuss the RMLE-based (score) method for constructing these confidence intervals. This method is based on (developed by, described by) Nam (1997).

### Asymptotic Tests

An asymptotic test for testing $H_{0L}$ versus $H_{1L}$ is given by

$$Z_L = \frac{\bar{D} + M_E}{\hat{\sigma}} = \frac{c + nM_E}{\sqrt{d - nD^2}} \geq z_{1-\alpha}$$

where

$$\bar{D} = \frac{n_T - n_S}{n} = \frac{n_{10} - n_{01}}{n}$$

$$d = n_{10} + n_{01}$$

$$c = n_{10} - n_{01}$$

and $z_{1-\alpha}$ is the standard normal deviate having $\alpha$ in the right tail.

Similarly, an asymptotic test for testing $H_{0U}$ versus $H_{1U}$ is given by

$$Z_U = \frac{\bar{D} - M_E}{\hat{\sigma}} = \frac{c - nM_E}{\sqrt{d - nD^2}} \leq -z_{1-\alpha}.$$ 

Equivalence is concluded if both the tests on $Z_L$ and $Z_U$ are rejected.

An estimate of $\hat{\sigma}$ based on the RMLE-based (score) procedure of Nam (1997) uses the estimates

$$\hat{\sigma}_L = \sqrt{\frac{\bar{p}_{L,10} + \bar{p}_{L,01} - M_E^2}{n}}$$
and

\[ \hat{\sigma}_U = \sqrt{\frac{\hat{p}_{U,10} + \hat{p}_{U,01} - M_E^2}{n}} \]

where

\[ \hat{p}_{L,01} = \frac{-\hat{a}_L + \sqrt{\hat{a}_L^2 - 8\hat{b}_L}}{4} \]

\[ \hat{p}_{L,10} = \hat{p}_{L,01} - M_E \]

\[ \hat{p}_{U,01} = \frac{-\hat{a}_U + \sqrt{\hat{a}_U^2 - 8\hat{b}_U}}{4} \]

\[ \hat{p}_{U,10} = \hat{p}_{U,01} + M_E \]

\[ \hat{a}_{L,01} = -\hat{b} (1 - M_E) - 2(\hat{p}_{01} + M_E) \]

\[ \hat{b}_{L,01} = M_E(1 + M_E) \hat{p}_{01} \]

\[ \hat{a}_{U,01} = -\hat{b} (1 + M_E) - 2(\hat{p}_{01} - M_E) \]

\[ \hat{b}_{U,01} = -M_E(1 - M_E) \hat{p}_{01} \]

Note that the ICH E9 guideline (see Lewis (1999)) suggests using a significance level of \( \alpha/2 \) when testing this hypothesis.

**Power Formula**

The power when the actual difference is \( D_1 \) can be evaluated exactly using the multinomial distribution. However, when the sample size is above a user-set level, we use a normal approximation to this distribution which leads to

\[
\text{Power} = \begin{cases} 
\Phi(c_U) - \Phi(c_L) & \text{if } c_U - c_L > 0 \\
0 & \text{otherwise}
\end{cases}
\]

where

\[ c_L = \frac{z_\alpha}{w_L} - \frac{D_1 + M_E}{\sigma} = \frac{z_\alpha}{w_L} - \frac{D_1 - D_{0,1}}{\sigma} \]

\[ c_U = -\frac{z_\alpha}{w_U} + \frac{M_E - D_1}{\sigma} = -\frac{z_\alpha}{w_U} + \frac{D_{0,1} - D_1}{\sigma} \]

\[ \sigma = \sqrt{\frac{p_{01} + p_{10} - D_1^2}{n}} \]

\[ w_L = \sqrt{\frac{2p_{01} + D_1 - D_1^2}{2\hat{p}_{L,01} - M_E - M_E^2}} = \sqrt{\frac{2p_{01} + D_1 - D_1^2}{2\hat{p}_{L,01} - D_{0,1} - D_{0,1}^2}} \]
Equivalence Tests for the Difference Between Two Correlated Proportions

\[ w_U = \frac{2p_{01} + D_1 - D_1^2}{2p_{01} + M_E - M_E^2} = \frac{2p_{01} + D_1 - D_1^2}{2p_{01} + D_{0,U} - D_{0,U}^2} \]

\[ \bar{p}_{L,01} = \frac{-a_L + \sqrt{a_L^2 - 8b_L}}{4} \]

\[ \bar{p}_{U,01} = \frac{-a_U + \sqrt{a_U^2 - 8b_U}}{4} \]

\[ a_L = -D_1(1 - M_E) - 2(p_{01} + M_E) = -D_1(1 + D_{0,L}) - 2(p_{01} - D_{0,L}) \]

\[ b_L = M_E(1 + M_E)p_{01} = -D_{0,L}(1 - D_{0,L})p_{01} \]

\[ a_U = -D_1(1 + M_E) - 2(p_{01} - M_E) = -D_1(1 + D_{0,U}) - 2(p_{01} - D_{0,U}) \]

\[ b_U = -M_E(1 - M_E)p_{01} = -D_{0,U}(1 - D_{0,U})p_{01} \]

**Nuisance Parameter**

The 2-by-2 table includes four parameters, \( p_{11}, p_{10}, p_{01}, \) and \( p_{00} \), but the power calculations only require two parameters: \( P_S \) and \( D_1 \). A third parameter is defined implicitly since the sum of the four parameters is one. Thus, one parameter (known as a nuisance parameter) remains unaccounted for. This parameter must be addressed to fully specify the problem. This fourth parameter can be specified using any one of the following: \( p_{11}, p_{10}, p_{01}, p_{00}, p_{10} + p_{01}, p_{11} + p_{00}, \) or the sensitivity of the experimental response, \( p_{11}/P_S \).

It may be difficult to specify a reasonable value for the nuisance parameter since its value may not be even approximately known until after the study is conducted. Because of this, we suggest that you calculate power or sample size for a range of values of the nuisance parameter. This will allow you to determine how sensitive the results are to its value.

**Procedure Options**

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

**Design Tab**

The Design tab contains the parameters associated with this test such as the proportions, sample sizes, alpha, and power.

**Solve For**

This option specifies the parameter to be solved for from the other parameters. The parameters that may be selected are *Power* or *Sample Size*. 
Power Calculation

Power Calculation Method
Select the method to be used to calculate power.

The choices are

- **Multinomial Enumeration**
  Power is computed using multinomial enumeration of all possible outcomes when \( N \leq \text{Max N} \) for Multinomial Enumeration (otherwise, the normal approximation is used). Multinomial enumeration of all outcomes is possible because of the discrete nature of the data.

- **Normal Approximation**
  Approximate power is computed using the normal approximation to the multinomial distribution.

The exact calculation using the multinomial distribution becomes very time consuming for \( N > 500 \). When \( N > 500 \), the difference between the multinomial and approximate calculations is small.

For small values of \( N \) (less than 100), the Multinomial Enumeration power may be overly optimistic because the discrete nature of the trinomial distribution results in the actual alpha value being higher than its target. To be on the safe side, we recommend that you use the approximate calculation.

**Max N for Multinomial Enumeration**

*Only shown when Power Calculation Method = “Multinomial Enumeration”*

Specify the maximum value of \( N \) (sample size) that uses the exact power calculation based on the multinomial distribution. \( N \)'s greater than this value will use the asymptotic approximation.

Power and Alpha

**Power**

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when you fail to conclude equivalence when in fact it is true.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

**Alpha**

This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. Here, a type-I error occurs when you falsely conclude equivalence.

Sample Size

**N (Sample Size)**

Enter a value for the sample size. This value must be greater than two. You may enter a range of values such as 10 to 100 by 10.
Effect Size – Differences

D0.L (Lower Equivalence Difference)
Enter D0.L, the lower equivalence bound for the difference, Pt - Ps. The upper equivalence bound is calculated as

\[ D0.U = |D0.L| \]

You can enter a single value such as -0.05 or a series of values such as -0.03 -0.05 -0.10 or -0.05 to -0.01 by 0.01 in the range -1 < D0.L < 0 and D0.L < D1 < D0.U.

D1 (Actual Difference)
Specify the actual difference, Pt - Ps, at which power will be calculated. This value is used to calculated Pt using the formula

\[ Pt = Ps + D1. \]

Often this value is set equal to zero, but this is not required. Enter values in the range D0.L < D1 < D0.U.

Be careful that the value you enter here along with other values in this procedure do not result in an undefined 2×2 table. The values entered in this procedure must result in a 2×2 table whose cell values and marginal totals each sum to 1.

Effect Size – Standard Proportion

Ps (Standard Proportion)
The proportion of Yes’s (positive responses or successes) when subjects receive the standard procedure.

You may enter a set of values separated by blanks. For example, you could enter 0.50 0.60 0.70. Enter values in the range 0 < Ps < 1.

Be careful that the value you enter here along with other values in this procedure do not result in an undefined 2×2 table. The values entered in this procedure must result in a 2×2 table whose cell values and marginal totals each sum to 1.

Effect Size – Nuisance Parameter

Nuisance Parameter Type
Enter the type of nuisance parameter here. Unfortunately, the 2-by-2 table cannot be completely specified by using only the parameters Ps and Da or Ps and Ra. One other parameter must be specified. This additional parameter is called a “nuisance” parameter. It will be assumed to be a known quantity. Several possible choices are available. This option lets you specify which parameter you want to use. In all cases, the value you specify is a proportion.

- P11 (% Positive Matches)
The proportion of subjects that are positive on both tests.

- P00 (% Negative Matches)
The proportion of subjects that are negative on both tests.

- P01 (% -Trt +Std)
The proportion of subjects that are negative on the treatment, but positive on the standard.

- P10 (% +Trt -Std)
The proportion of subjects that are positive on the treatment, but negative on the standard.
- **P11+P00 (%) Matches**
  The proportion of matches (concordant pairs).

- **P01+P10 (%) Disagree**
  The proportion of non-matches (discordant pairs).

- **P11/Ps (Sensitivity)**
  The sensitivity.

**Nuisance Parameter Value**
Enter the value of the nuisance parameter that you specified in the “Nuisance Parameter Type” box. This value is a proportion, so it must be between 0 and 1.
Example 1 – Finding Power

A clinical trial will be conducted to show that a non-invasive MRI test is equivalent to the invasive CTAP reference test. Historical data suggest that the CTAP test is 80% accurate. After careful discussion, the researchers decide that if the MRI test is within five percentage points of the CTAP, it will be considered equivalent. They decide to use a difference test statistic. Thus, the equivalence difference is 0.05. They want to study the power for various sample sizes between 200 and 1000 at the 5% significance level.

They use P01 as the nuisance parameter and look at two values: 0.05 and 0.10.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Equivalence Tests for the Difference Between Two Correlated Proportions procedure window by expanding Proportions, then Two Correlated Proportions, then clicking on Equivalence, and then clicking on Equivalence Tests for the Difference Between Two Correlated Proportions. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Power Calculation Method</td>
<td>Normal Approximation</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>N (Sample Size)</td>
<td>200 300 450 600 800 1000</td>
</tr>
<tr>
<td>D0.L (Lower Equivalence Difference)</td>
<td>-0.05</td>
</tr>
<tr>
<td>D1 (Actual Difference)</td>
<td>0.0</td>
</tr>
<tr>
<td>Ps (Standard Proportion)</td>
<td>0.80</td>
</tr>
<tr>
<td>Nuisance Parameter Type</td>
<td>P01 (% -Trt +Std)</td>
</tr>
<tr>
<td>Nuisance Parameter Value</td>
<td>0.05 0.10</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0.35542</td>
<td>200</td>
<td>-0.050</td>
<td>0.050</td>
<td>0.000</td>
<td>0.800</td>
<td>0.800</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.00000</td>
<td>200</td>
<td>-0.050</td>
<td>0.050</td>
<td>0.000</td>
<td>0.800</td>
<td>0.800</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.66488</td>
<td>300</td>
<td>-0.050</td>
<td>0.050</td>
<td>0.000</td>
<td>0.800</td>
<td>0.800</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.20739</td>
<td>300</td>
<td>-0.050</td>
<td>0.050</td>
<td>0.000</td>
<td>0.800</td>
<td>0.800</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.88574</td>
<td>450</td>
<td>-0.050</td>
<td>0.050</td>
<td>0.000</td>
<td>0.800</td>
<td>0.800</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.51491</td>
<td>450</td>
<td>-0.050</td>
<td>0.050</td>
<td>0.000</td>
<td>0.800</td>
<td>0.800</td>
<td>0.800</td>
<td>0.050</td>
</tr>
</tbody>
</table>

* Power was computed using the normal approximation method.
**Report Definitions**

- **Power** is the probability of rejecting the null hypothesis when it is false.
- **N** is the number of subjects, the sample size.
- **D0.L** and **D0.U** are the lower and upper difference bounds, respectively, used to construct the equivalence hypotheses.
- **D1 = Pt - Ps** is the actual difference at which the power is calculated.
- **Pt** is the response proportion in the treatment (experimental) group.
- **Ps** is the response proportion in the standard (baseline, reference, or control) group.
- **The Nuisance Parameter** is a value that is needed, but is not a direct part of the hypotheses.
- **Alpha** is the probability of rejecting the null hypothesis when it is true.

**Summary Statements**

For an equivalence test of the difference between two correlated proportions, a sample size of 200 subjects achieves 35.542% power at a significance level of 0.050 when the lower equivalence difference is -0.050, the upper equivalence difference is 0.050, the treatment proportion is 0.800, the standard proportion is 0.800, and the actual difference between the proportions is 0.000. These results assume that P01 is equal to 0.050.

This report shows the power for the indicated scenarios. All of the columns are defined in the “Report Definitions” section.

**Plots Section**

These plots show the power versus the sample size for the two values of P01. In this example, we see that the value of the nuisance parameter has a large effect on the calculated sample size.
Example 2 – Finding Sample Size

Continuing with Example 1, the analysts want to determine the exact sample size necessary to achieve 90% power for both values of the nuisance parameter.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Equivalence Tests for the Difference Between Two Correlated Proportions procedure window by expanding Proportions, then Two Correlated Proportions, then clicking on Equivalence, and then clicking on Equivalence Tests for the Difference Between Two Correlated Proportions. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

Option | Value
--- | ---
**Design Tab**
Solve For | Sample Size
Power Calculation Method | Normal Approximation
Power | 0.90
Alpha | 0.05
D0.L (Lower Equivalence Difference) | -0.05
D1 (Actual Difference) | 0.0
Ps (Standard Proportion) | 0.80
Nuisance Parameter Type | P01 (% -Trt +Std)
Nuisance Parameter Value | 0.05 0.10

Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>468</td>
<td>-0.050</td>
<td>0.050</td>
<td>0.000</td>
<td>0.800</td>
<td>0.800</td>
<td>0.050</td>
<td>0.050</td>
</tr>
<tr>
<td>881</td>
<td>-0.050</td>
<td>0.050</td>
<td>0.000</td>
<td>0.800</td>
<td>0.800</td>
<td>0.100</td>
<td>0.050</td>
</tr>
</tbody>
</table>

* Power was computed using the normal approximation method.

This report shows that the sample size required nearly doubles when P01 is changed from 0.05 to 0.10.
Example 3 – Finding Power Following an Experiment

An experiment involving a single group of 57 subjects was run to show that a new treatment was equivalent to a previously used standard. Historically, the standard treatment has had a 48% success rate. The new treatment is known to have similar side effects to the standard, but is much less expensive. The treatments were to be considered equivalent if the success rate of the new treatment is within 10% of the success rate of the standard.

To compare the new and standard treatments, each of the 57 subjects received both treatments with a washout period between them. Thus, the proportions based on the two treatments are correlated. Of the 57 subjects, 18 responded to both treatments, 20 did not respond to either treatment, 9 responded to the new treatment but not the standard, and 10 responded to the standard but not the new treatment. The proportion responding to the new treatment is $(18+9)/57 = 0.4737$. The proportion responding to the standard is $(18+10)/57 = 0.4912$. The difference is 0.0175, lower than the threshold for equivalence, but the resulting p-value was 0.3358, indicating the two treatments could not be deemed equivalent at the 0.05 level. Note that McNemar’s test only uses the discordant pairs, so the effective size of this study is really only $9 + 10 = 19$, although 57 subjects were investigated. The researchers want to know the power of the test they used.

It may be the inclination of the researchers to use the observed difference in proportions for calculating power. The p-value, however, is based on the maximum allowable difference for equivalence, which is 10% of 0.48, or 0.048. This is the number that should be used in the power calculation. The experiment gave a value of P01 of $10/28 = 0.36$. The power of the experiment is near zero for all values of P01 less than 0.10. We calculate the power for a variety of nuisance parameter values ($P01 = 0.01, 0.03, 0.05, and 0.10$) to monitor its effect. Because it is in fact believed that the success rates are equivalent for the two treatments, the specified actual difference is set to 0.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Equivalence Tests for the Difference Between Two Correlated Proportions procedure window by expanding Proportions, then Two Correlated Proportions, then clicking on Equivalence, and then clicking on Equivalence Tests for the Difference Between Two Correlated Proportions. You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Power Calculation Method</td>
<td>Multinomial Enumeration</td>
</tr>
<tr>
<td>Max N for Multinomial Enumeration</td>
<td>1000</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>N (Sample Size)</td>
<td>57</td>
</tr>
<tr>
<td>D0.L (Lower Equivalence Difference)</td>
<td>-0.048</td>
</tr>
<tr>
<td>D1 (Actual Difference)</td>
<td>0.0</td>
</tr>
<tr>
<td>Ps (Standard Proportion)</td>
<td>0.48</td>
</tr>
<tr>
<td>Nuisance Parameter Type</td>
<td>P01 (% -Trt +Std)</td>
</tr>
<tr>
<td>Nuisance Parameter Value</td>
<td>0.01 0.03 0.05 0.10</td>
</tr>
</tbody>
</table>
Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0.31614</td>
<td>57</td>
<td>-0.048</td>
<td>0.048</td>
<td>0.000</td>
<td>0.480</td>
<td>0.480</td>
<td>0.010</td>
<td>0.050</td>
</tr>
<tr>
<td>0.02940</td>
<td>57</td>
<td>-0.048</td>
<td>0.048</td>
<td>0.000</td>
<td>0.480</td>
<td>0.480</td>
<td>0.030</td>
<td>0.050</td>
</tr>
<tr>
<td>0.00247</td>
<td>57</td>
<td>-0.048</td>
<td>0.048</td>
<td>0.000</td>
<td>0.480</td>
<td>0.480</td>
<td>0.050</td>
<td>0.050</td>
</tr>
<tr>
<td>0.00000</td>
<td>57</td>
<td>-0.048</td>
<td>0.048</td>
<td>0.000</td>
<td>0.480</td>
<td>0.480</td>
<td>0.100</td>
<td>0.050</td>
</tr>
</tbody>
</table>

* Power was computed using multinomial enumeration of all possible outcomes.

Note that there is no power for value of P01 greater than 0.05. This is probably due to the low number of discordant pairs.
Example 4 – Validation using Liu et al. (2002)

Liu et al. (2002) page 238 give a table of power values calculated by multinomial enumeration for sample sizes of 50, 100, and 200 when the significance level is 0.05. From this table, we find that when P01 is 0.10, P10 is 0.10, D1 = P01 - P10 = 0.00, and the equivalence difference is 0.10, the three power values are 0.026, 0.417, and 0.861 for the column head “RMLE-based Without CC” (this is the case we use).

In their calculations, they round the z value to 1.64. This corresponds to an alpha value of 0.0505025835. So that our results match, we will use this value for alpha rather than 0.05. In this example, the value of Ps is not used.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Equivalence Tests for the Difference Between Two Correlated Proportions procedure window by expanding Proportions, then Two Correlated Proportions, then clicking on Equivalence, and then clicking on Equivalence Tests for the Difference Between Two Correlated Proportions. You may then make the appropriate entries as listed below, or open Example 4 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Power Calculation Method</td>
<td>Multinomial Enumeration</td>
</tr>
<tr>
<td>Max N for Multinomial Enumeration</td>
<td>1000</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.0505025835</td>
</tr>
<tr>
<td>N (Sample Size)</td>
<td>50 100 200</td>
</tr>
<tr>
<td>D0.L (Lower Equivalence Difference)</td>
<td>-0.1</td>
</tr>
<tr>
<td>D1 (Actual Difference)</td>
<td>0.0</td>
</tr>
<tr>
<td>Ps (Standard Proportion)</td>
<td>0.5</td>
</tr>
<tr>
<td>Nuisance Parameter Type</td>
<td>P01 (% -Trt +Std)</td>
</tr>
<tr>
<td>Nuisance Parameter Value</td>
<td>0.1</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>Sample</th>
<th>Lower Equiv.</th>
<th>Upper Equiv.</th>
<th>Actual Difference</th>
<th>Treatment Proportion</th>
<th>Standard Proportion</th>
<th>Nuisance Parameter</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.02614</td>
<td>50</td>
<td>-0.100</td>
<td>0.100</td>
<td>0.000</td>
<td>0.500</td>
<td>0.500</td>
<td>0.100</td>
<td>0.051</td>
</tr>
<tr>
<td>0.41741</td>
<td>100</td>
<td>-0.100</td>
<td>0.100</td>
<td>0.000</td>
<td>0.500</td>
<td>0.500</td>
<td>0.100</td>
<td>0.051</td>
</tr>
<tr>
<td>0.86080</td>
<td>200</td>
<td>-0.100</td>
<td>0.100</td>
<td>0.000</td>
<td>0.500</td>
<td>0.500</td>
<td>0.100</td>
<td>0.051</td>
</tr>
</tbody>
</table>

* Power was computed using multinomial enumeration of all possible outcomes.

As you can see, the values computed by PASS match the results of Liu et al. (2002).